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AVS Convertor: DVD Video Files to Web Compatible Files 

The Process 
A video DVD has a collection of large files and folders designed to be read locally. But not designed for the web. Our 
mission is to convert this collection of files to compact ones that can read by the browser. To oversimplify, we want to 
convert the DVD file collection into one SWF (Flash) file. However the SWF needs help files to display it in a controlled 
(designed) and seamless (errorless) fashion. This paper will walk you through the process.  

Here is an outline of the steps, a detailed walk-through follows: 

1. Examine the contents. 

2. Copy files from DVD to hard drive. 

3. Convert file-set to one file. 

4. Convert file to FLV (compressed file for Flash).  
A professional application will combine steps 3 and 4. 

5. Import FLV into Flash (FLA file). 

6. Publish FLA to SWF, which will generate dependant files. 

7. Post SWF and dependant files onto the Web Server, (in our case/at this date, Oraweb5). 

8. Put HTML and JavaScript in a Text box that links to an HTML file on Orwaweb5. 

Here is what the finished file-set looks like: 

Templates are kept on the JMH Share Drive:  
 S:\Intranet Development\Intranet Content\COMMON ELEMENTS\dvd2swf  

Examine the contents. 
Determine if the files are movies and can be converted to web-compatible files. It may be an executable (EXE) 
application. 

If it is not suitable for the intranet refer the Client to JMH Learning Point, they are in a better position to accommodate 
their needs. 

1. Put the DVD in the DVD drive  

2. Open My Computer in Windows Explorer 

3. Select the DVD drive  

4. Right-Click and choose Explore DVD drive  

Typically video files are in folders titled:  

VIDEO_TS 
AUDIO_TS (not all movies with audio have a separate Audio folder) 

5. If the DVD does not have the VIDEO_TS folder examine it closer, open the files, until you know what they are 
and determine if they can be converted for a Web Server. 



Copy the files to your hard drive. 
Create a folder with the movie name. The names are more sensitive than they are for the Oracle Portal as you are 
writing for JavaScript and ActionScript. 

• No capitals (mysteriously will not play the movie in Oracle) 

• No spaces 

• No special characters, except for an underscore ( _ ) 

• Start the name with a letter, not a number 

• Truncate the names, the shorter, the better (best practice)  

Make a sub-folder for each stage of the process. Your folder tree should look something like this: 

Converting software. 
There are many variations of video files, even within the same format. They are targeting multiple operating systems and 
multiple media players. They are improving, therefore changing… Within the same format, i.e., AVI or MPG, etc., 
different codecs are used. Which is beyond the scope of this paper, or author, to explain.  

I mention this to arm you against files that do not convert for mysterious reasons. And to let you know what I found to 
work. The QuickTime – MOV format, not the current popular/generic (AVI or MPG), is successful most often. But if one 
format does not work try again targeting a different format. The FVE is versatile; I am not aware of a format that it cannot 
convert to FLV. 

Listed below are my experiences with the applications I’ve been using. 

• Cinematize by Miraizon. Was recommend by a JMH employee and therefore purchased by the IDG. – Now 
Vista compatible  
My experience has been inconsistent and I have stopped using it. 

• DVD-to-AVI by FlexImage. Was also recommend by a JMH employee as the most reliable he’s ever used. I only 
used it once (trial), it did not solve the problem of the moment. 

• AVS Video by AVS4You. I like the interface and it has successfully converted most (~90%) files into MOV files 
intact. – Now Vista compatible  

The applications range in price from $25-$60 and are considered pedestrian, not designed for the professional. The 
Professional version of any of them would undoubtedly be more helpful. – The least to be expected from a Professional 
video converter is that the conversion of the video file-set to FLV can be done in one step. 

The instructions that follow will refer to the AVS Video application. 
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Convert the file-set to one file. 
Convert the DVD file-set, VIDEO_TS, to a computer-friendly single file that plays in a Media Player. These will play in the 
browser but are cumbersome as they need the 
players. The SWF movie will play seamlessly in a 
web page and is significantly smaller. 

1. Open AVS Video 

2. Click the button to the right of the Input File 
Name field and browse to the VIDEO_TS 
folder. 

This is a typical VIDEO_TS file-set: 

3. Select the VIDEO_TS.IFO file 

4. Choose the format: Click the MOV icon (or other) in the top row of buttons 

Do not select the SWF option as this would skip the compression that takes place in the Flash Video Encoder 
(FVE). 

5. Click the Browse button to the right of the Output File Name box and browse to the mov (or format you are 
converting to) folder that you created for this movie 

Name the file to match your end movie name.  

6. Click the Arrow to the right of the QT Profile box to choose a lower quality of video. This will reduce your file size 
but retain quality sufficient for the small screen 

7. Double-Click the Advanced button to learn the length of the movie. – See the last line titled: Duration 

Click the Advanced button again to close this portion of the window. 

The conversion begins, while AVS is working you can do something else. – Consider the files ‘in the oven’. A pop-up 
window will alert you when the conversion is complete. 

Test the movie. 
1. Double-click the new movie to open it in the media player 

2. When satisfied continue. 

3. Close the media player 
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Convert file to FLV  
The Flash Video Encoder uses a ‘Hollywood’ industry level compressing engine (Sorenson Squeeze) to compress the 
movies, without loss of quality, before it is brought into Flash. 

1. Open the Flash Video Encoder (included with CS3) 

2. Click the Add button & browse to the single movie file. 

3. Click the Settings button 

A dialog Window with tabs opens. 

4. Select the Audio tab. 

5. Pull down the drop-down menu and choose 16kbs mono 

Dialog does not require stereo so choosing mono cuts the audio 
portion of the files by half without loss of quality. 

6. Click OK. 

7. Click the Start Queue button  

The conversion begins, while the FVE is working you can do something else. – Consider the files ‘in the oven’. 
There will be no alert when it is finished, you'll have to check, however there is a Time left report on the screen. 

8. Upon completion: Manually move your FLV file to the pub folder when it is complete, this will keep your links 
intact for publication. (FVE provides a custom setting location of finished files; it is more practical to manually 
move them after each conversion.) 

Generate a SWF & dependant files. 
Flash generates a collection of files required to play the SWF movie seamlessly in the browser. In the FLA file you will 
tell Flash to save them in your pub folder (Step 4 below). Flash will generate a HTML file (along with other required files) 
with links based on this information.  

1. Copy the FLA template (made for JMH movies) in your pub folder. 

2. Open the MOV (or AVI) folder and (if you have not already) drag your 
new FLV file to the pub folder. 

3. Open the FLA template. 

4. Save as movie_name.fla 

5. Modify the Publish Settings (File > Publish Settings):  

a. SWF: Browse to the pub folder to save as movie_name.swf 

b.  Browse to the pub folder to save as movie_name.html  
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6. Import the FLV (File > Import > Import Video): 

a.  Browse to the FLV file 

b. Click Next on each screen, accept the defaults. 

The method of display, called the ‘skin’ i.e., the Control Bar 
properties, is created here. 

c. Click OK on the last screen. 

7. Place the movie on the Flash ‘Stage’  

8. Adjust the Properties 

• Dimensions: 640px by 480px  

• Position: X 10px and Y 8px  

9. Test the movie (CNTL + Enter) 

Check the proportions; the 640 x 480 works well for standard size movies but always check that the width/
height ratio is in proportion for your movie.  

If the W/H ratio is disproportionate: 

a. Adjust the dimensions (see illustration above) until they look 
correct.  

b. Adjust the Flash ‘Stage’ size (‘Canvas’ in other applications) 

If the Stage size changes you also need to change the size of the pre-
sized window. Directions in the Post the Movie section. 

c. Adjust the alignment: (Window > Align) 

i. Click the Align to Stage icon 

ii. Select the movie  

iii. Select the Align-Vertical/Center icon to center align the movie 

iv. Manually align the Horizontal position as the Control Bar of the movie throws off the Flash 
alignment tool. 
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10. Test the movie 

11. When satisfied, Publish the movie (File > Publish). 

Display Title  
Flash will display the movie with the truncated name you gave to the files. But you want a Reader-Friendly name 
displayed in the Browser Window Title Bar. The title is in the HTML page so we will edit it to display the Reader-Friendly 
title of the movie. 

The green text below is what appears in the browser Title Bar. 

Before: <title>hit</title>  

After: <title>Heparin-Induced Thromboctopenia: A Clinical Diagnosis</title>  

1. Open the HTML file and edit in any Text Editor (not a Word Processor) the following Text Editors are used in the 
ITS IDG office: 

• Dreamweaver – Design window option (GUI)  

• Adobe ExtendScript Toolkit (included with CS3) 

• MS Notepad 

2. Change the text (green above) that is between the opening and closing TITLE Tags. 

Post the movie. 
Use a File Transfer Protocol (FTP) application to post the files on Oraweb5. A common FTP application at JMH ITS is 
WinSCP. (FreeWare) 

1. Open the FTP application WinSCP  

2. Log on to Oraweb 5 (first time only) 

• Web Address: 172.18.6.198  

• Your EID#: ####  

• Your Password: xxxxx  

• Save your first login and you can connect with just a double-click 
when you return. 

3. Browse or create a folder as you would in Windows Explorer 

• Double-click to open folders 

• Drag and Drop files and folders 
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• The icons are buttons—use them to navigate to folders and files 

4. Create a new sub-folder for the movie (F7) in the OW5 pane 

5. Copy the files from the pub folder into the new folder. 

• Select & Drag 

6. Exit (F10) 

• All the URLs will be: http://intranetdocs/intranet/site_name/movie_name/movie_name.html 

Put link in an Oracle Text Item. 
A JS file template has been created. It contains the global URL but needs to be modified for your new movie. Use 
Dreamweaver or ExtendScript Toolkit to make the modifications and tags will be color coded, making reading easier. 

1. Open the videoWindow.js file  

2. Make the following changes in the HTML and JavaScript. 

• Change the old movie folder and file names to the new names. (Green text below) 

• Change the Window name to a unique name; no special characters or spaces, short/truncated but relevant 
to the movie. (Orange text below.) 

• If the movie size was changed, change the window width and height. (Blue text below)  

• Optional: The display link and color (Reader-friendly, descriptive name) can also be changed at this time, or 
you can change it in Oracle Design Mode. See the Purple text to change it at this time. 

<SCRIPT type=text/javascript> 
<!-- 
function MM_openBrWindow(theURL,winName,features) { //
v2.0 
 window.open(theURL,winName,features); 
} 
//--> 
</SCRIPT> 
 
 
<P><A onclick="MM_openBrWindow('http://intranetdocs/
intranet/wc_nurses_ccpc/hit/hit.html', 
'heparin','scrollbars=yes,resizable=yes,width=680,height=
570')" href="javascript:;" align="center"><FONT 
face="Verdana" color=#5f6a00 size=2>Heparin-Induced 
Thromboctopenia: A Clinical Diagnosis</FONT></A><BR><FONT 
face=Verdana color=#fea400 size=2>Video</FONT></P> 

3. Select and copy the new text 

4. Open Oracle Text Box in HTML Mode 

5. Paste into Oracle Text Box HTML Mode 

6. Change to Design Mode 

7. (If it not done earlier) edit display link name for current movie 

8. Modify color if necessary  

9. Optional: Add bullet per page design 

10. Click OK 

11. Test your link 
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Movie Posted! 
Your movie link should look like any other Text Link on the page. When it opens the new window will be just big enough 
to frame the movie. The movie will have a pause button, a play button and a volume control. As you do more of these 
you will learn how to modify these properties. 

 

Enjoy! 
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